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1  Introduction 

  About this document 
This is the operation manual for WinActorEye. 
This manual is intended for those who create scenarios for WinActor using 
WinActorEye. 

 

  Trademarks 
The names described below and other names of companies and products in this 
document are trademarks or registered trademarks of their respective companies. 
The TM, ®, and © marks are omitted in this document. 
 

・ Windows, Microsoft .NET Framework, and Microsoft Edge are trademarks or 
registered trademarks of Microsoft Corporation in the United States and other 
countries. 

* The official name of Windows is Microsoft Windows Operating System. 
 

・ The names of other companies and products are trademarks or registered 
trademarks of their respective companies. 

 

 Notes on this manual  

・ The copyright notice "Copyright © 2013-2025 NTT, Inc. & NTT ADVANCED 
TECHNOLOGY CORPORATION" attached to this manual and the provided 
software cannot be changed or deleted. 
The copyright of this manual belongs to NTT, Inc. and NTT ADVANCED 
TECHNOLOGY CORPORATION. 

・ The descriptions in this manual assume that users understand Windows 
operations and functions. For information that is not described in this manual, see 
the documents provided by Microsoft. 
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  Recommended environment 
In addition to the contents described in "Recommended environment" in "WinActor 
Operation Manual," it is recommended that the environment in which WinActorEye is 
used meets the specifications described in "1.4.1 Hardware environment" and "1.4.2 
Software environment." 
 

1.4.1  Hardware environment 

Table 1-1. Recommended specifications 

Item Recommended specifications 

CPU 
2.5 GHz or higher x86 or x64 processor 
4 cores or more 

 
 

1.4.2  Software environment 
Table 1-2 shows the environmental conditions (software) for using Microsoft OCR. 

Table 1-2. Environmental conditions (software) for Microsoft OCR 

Item Outline specifications 

OS 
Microsoft Windows Server 2016 
Microsoft Windows Server 2019 

Microsoft 
.NET Framework 

Version 4.8 or higher 
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  Launching WinActorEye 
To open the WinActorEye window, click "WinActorEye" in the "Tool" menu of 
WinActor. 

 

  

Figure 1-1. Launching WinActorEye 
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2  WinActorEye 

  About WinActorEye 

WinActorEye is a tool to search for a target image and generate coordinate 

information by creating and running a WinActorEye macro that combines various 

search conditions. 

The relationship between WinActorEye and WinActor is as follows. 

 

 

Figure 2-1. Relationship diagram between WinActorEye and WinActor 

 

By specifying and running a WinActorEye macro from the WinActor library, 

WinActorEye runs operations recorded in the macro. WinActor gets coordinate 

information from WinActorEye and performs operations such as mouse click by using 

existing nodes and libraries. For how to create a scenario using WinActorEye, see 

"WinActorEye Scenario Creation Manual." 

Compared with the existing Image Matching and Contour Matching, WinActorEye 
has the following distinctions. 
 

・Achieves strong matching against desktop size changes 

・Adjustable while checking results when matching fails 
 
 
  



 

5 

 

 

  Terms and descriptions  
The terms commonly used in the description of WinActorEye are explained below. 
As an example, it is assumed here that you want to search for the "submit" button on 
the page where the WinActor sample file "Tutorial.html" is opened in Microsoft Edge 
(hereinafter, Tutorial page).  
 

Table 2-1. List of terms and descriptions 

No. Term Description 

1 Reference base 

image 

An image that contains a target to be searched. 
In Figure 2-2, it is the captured image of the Tutorial 
page.  

2 Reference image An image to be searched. 
In Figure 2-2, it is the image of the "submit" button cut 
out from the captured image of the Tutorial page. 

3 Image resource Image data such as PNG is input/output and managed 
as image information on WinActorEye. It is used to 
output various filters and image files. 
In Figure 2-3, the captured image of the Tutorial page is 
displayed as an image resource.  

4 Rectangle resource Rectangle information drawn as a rectangle on the main 
window of WinActorEye (see "3.1 Main window"). It 
holds the x-coordinate, y-coordinate, rectangle width 
and height, and angle information of the upper left 
vertex of the rectangle. It is used to specify a range or to 
check the matching result. 
In Figure 2-3, a red frame surrounding the "submit" 
button is displayed as a rectangle resource. 

5 Coordinate resource Coordinate information drawn in a circle on the main 
window of WinActorEye (see "3.1 Main window"). It 
holds the x-coordinate and y-coordinate information of 
the center of the circle. It is used when performing a 
mouse action in WinActor. 
In Figure 2-3, the coordinates of the center of the 
"submit" button are displayed with a red circle as a 
coordinate resource. 

6 Color resource Color information (RGBA) output by "Color picker tool." 
By specifying this as an input item of "Search specified 
color," it is possible to search by specifying a color. 

7 Matching It is to search an image resource for a part that matches 
a reference image or search target characteristics 
(color, shape, etc.). 

8 Work folder This is the starting point for running WinActorEye. 
Any folder can be set. 

 
 

 

"Tutorial.html" is stored in the "WinActor_Documents\English\Tutorial" folder under the 

‘Installation folder’ of WinActor or the “winactor_documents\English\Tutorial” folder 

under the ‘User folder’ of WinActor. 
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Figure 2-2. "Reference base image" and "Reference image" 

 

 

Figure 2-3. Resource illustration 
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  Operation flow of WinActorEye 
The processing flow is as follows. (For details, see each chapter.)  
 

 

Figure 2-4. Operation flow image 

 

① Specify a window or load an image file to get a reference base image. (See "4 
Input") 

② Specify a target range for image matching in the reference base image to get a 
reference image. (See "6 Edit image") *1, 2 

③ As shown in the figure above, specify a processing according to characteristics 
(color, shape, etc.) of the target for matching. (See "7 Filter") 

④ Adjust parameters based on the processing result of ③. *3 

⑤ The candidate area can be narrowed down by multiplying multiple processing 
results. In the example in the above figure, only the candidate that is common to 
the results of Filter A and Filter B is narrowed down. (See "7.7 Boolean 
operation") 

⑥ Convert rectangle information to coordinate information. By storing the extracted 
coordinate information in the variables of WinActor, the mouse action becomes 
possible. (See "7.9 Extract coordinates from rectangle") 

 
*1. A reference image can also be acquired by loading an image file.  
*2. Some images do not require a reference image depending on the filter used. 
*3. Information acquired as a processing result would be an image resource, 
rectangle resource, coordinate resource, or color resource. 



 

8 

 

 

 

3  Main window 

  Main window 

The main window is a window that appears when you launch WinActorEye. 

 

 

Figure 3-1. Main window 

 

Table 3-1. Window elements 

No. Element Description 

① Menu bar Shows menus for executing each function. 

② Image input area Accepts various resource displays and mouse 
operations.  

③ Resource area Shows various resource information. 

④ Preview area Shows the input resource of each function and its 
resource information.  

⑤ WorkFolder Shows a current work folder. 

⑥ Zoom level Shows the zoom level of the image input area.  
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 Docking window 
The docking window is a function that allows you to float the resource area, the 

property area, and the preview area for each menu item, and place them anywhere 
on the screen.  

 

3.2.1  Dragging a title bar 

You can change a position of the resource area, the property area, or the preview 

area for each menu item by dragging their title bar with the mouse to float the area 

and dropping it to your desired position. 

 

   

Figure 3-2. Dragging the title bar ① 
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For example, you can change the position of the property area by dragging and 

dropping its title bar.  

 

 

Figure 3-3. Dragging the title bar ② 

  

3.2.2  Dragging a tab 

You can change a position of the resource area, the property area, or the preview 

area for each menu item by dragging its tab with the mouse to float the area and 

dropping it to your desired position. 

 

For example, you can change the position of the "Snapshot" property area by 

dragging and dropping its tab.  

 

 

Figure 3-4. Dragging the tab 
 

3.2.3  Docking (entire window area) 

You can place (dock) a floating window inside WinActorEye by dragging and 
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dropping it onto WinActorEye. 

 

Drag a floating window onto WinActorEye. The control appears on the four sides of 

WinActorEye. 

  

Figure 3-5. Docking (entire window area) ① 
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Overlay the floating window on the control. The docking position will be displayed 

in a blue frame. 

 

 

Figure 3-6. Docking (entire window area) ② 
 

 

Drop the window to dock it at the position of the blue frame. 

  

Figure 3-7. Docking (entire window area) ③ 
 

3.2.4  Docking (resource/property/preview area) 

You can dock a floating window or place it as a tab by dragging and dropping it to 

the resource area, the property area, or the preview area for each menu item. 
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Drag a floating window to the resource area, the property area, or the preview area 

for each menu item. The control appears on the center of the area. 

 

 

 

Figure 3-8. Docking (resource/property/preview area) ① 
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Drop the floating window to the right, left, top, or bottom of the control. 

  

Figure 3-9. Docking (resource/property/preview area) ② 

 

The window will be docked in the corresponding position (right, left, top, or bottom) 
of the area. 

  

Figure 3-10. Docking (resource/property/preview area) ③ 

 

Drop the floating window to the center of the control. 
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Figure 3-11. Docking (tabbed) ① 

 

The window will be docked as a tab. 

  

Figure 3-12. Docking (tabbed) ② 

 

3.2.5  Float/Dock menu 

Click ▼ in the upper right of the resource area, the property area, or the preview 
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area for each menu item to display the menu. Select "Float" in the displayed menu to 

float the selected tab. 

 

 

 

Figure 3-13. Float/Dock menu 

 

Select "Dock" in ▼ in the upper right of the floating window to dock it in its original 

position. 

 

Select "Close" in ▼ or click ‘×’ in the upper right of the window to close the selected 

tab. 
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3.2.6  Saving and restoring the layout 
The layout is automatically saved and restored when you quit and launch 

WinActorEye. 

・When quitting WinActorEye: The current layout will be saved. 

・When launching WinActorEye: The saved layout will be restored. If the layout has 

never been saved, the default layout will be restored. 
 

You can also save and restore the layout from the "View" menu of the menu bar. 
 

 

 

Figure 3-14. Saving and restoring the layout 

 

 

Table 3-2. Saving and restoring the layout 

No. Menu Description 

① Save current layout Saves the current layout 

② Restore layout Restores the saved layout. 

③ Restore initial layout Restores the default layout. 
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  Operations in the image input area 

The operations that can be performed in the image input area are as follows.  

 

Table 3-3. List of operations in the image input area 

No. Operation Description 

1 Registering an image 

resource 

Drag and drop an image file into the image input area. 
For details, see "3.3.1 Registering an image resource." 

2 Creating a rectangle 

resource 

Drag the mouse over an image resource displayed in 
the image input area. 
For details, see "3.3.2 Registering a rectangle 
resource." 

3 Creating a coordinate 

resource 

Click on an image resource displayed in the image 
input area.  
For details, see "3.3.3 Registering a coordinate 
resource." 

4 Editing/viewing a 

rectangle resource 

With one or more rectangle resources registered, 
right-click on an image resource displayed in the 
image input area. 
For details, see "3.3.4 Editing/viewing a rectangle 
resource." 

5 Editing/viewing a 

coordinate resource  

With one or more coordinate resources registered, 
right-click on an image resource displayed in the 
image input area.  
For details, see "3.3.5 Editing/viewing a coordinate 
resource." 
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3.3.1  Registering an image resource 

 

Figure 3-15. Registering an image resource on the image input area 

 

 You can register an image resource by dragging and dropping an image file into 

the image input area (① in Figure 3-15). The filename of the dragged and dropped 

image will be registered as the image resource name, and it will be in the selected 

state (displayed on the main window) (② in Figure 3-15). 

For other methods of registering an image resource, see "4 Input." 

The "Image resource" pane is displayed in the resource area. 

The "Image resource" pane can also be displayed by clicking "Image resource" in 

the "View" menu. For the "Image resource" pane, see "10.3 Image resource." 
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3.3.2  Registering a rectangle resource 

 

Figure 3-16. Registering a rectangle resource on the image input area 

 

You can register a rectangle resource by dragging the mouse over a target and 

specifying its range on an image resource displayed in the image input area (① in 

Figure 3-16). The rectangle information created by dragging will be registered in the 

rectangle resource named "MAIN" (② in Figure 3-16). You can update the rectangle 

information of "MAIN" by dragging again. You can also register information of multiple 

rectangles in "MAIN" by dragging while holding down the ‘Ctrl’ key. 

The "Rectangle resource" pane can be displayed by selecting its tab in the 

resource area or by clicking "Rectangle resource" in the "View" menu. For the 

"Rectangle resource" pane, see "10.4 Rectangle resource." 

  



 

21 

 

 

 

3.3.3  Registering a coordinate resource 

 

Figure 3-17. Registering a coordinate resource on the image input area 

 

 You can register a coordinate resource by clicking a target on an image resource 

displayed in the image input area (① in Figure 3-17). The coordinate information 

created by clicking will be registered in the coordinate resource named "MAIN" (② in 

Figure 3-17). You can update the coordinate information of "MAIN" by clicking again. 

You can also register information of multiple coordinates in "MAIN" by clicking while 

holding down the ‘Ctrl’ key.  

The "Coordinate resource" pane can be displayed by selecting its tab in the 

resource area or by clicking "Coordinate resource" in the "View" menu. For the 

"Coordinate resource" pane, see "10.5 Coordinate resource." 
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3.3.4 Editing/viewing a rectangle resource 

  

 

Figure 3-18. Editing a rectangle resource on the image input area 

 
With one or more rectangle resources registered, right-click on an image resource 

to display the menu (Figure 3-18). 
Click "Edit/View rectangle information" in the displayed menu to open the 

"Edit/View rectangle information" window (Figure 3-19). 
 

  

Figure 3-19. "Edit/View rectangle information" window 
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In the "Edit/View rectangle information" window, you can edit the rectangle 
information of the rectangle resource for each parameter. The rectangle information 
of the selected "Index" is displayed as a thick red line on the image input area (Figure 
3-20). 

 

Table 3-4. "Edit/View rectangle information" window elements 

No. Element Description 

① Rectangle resource name You can select the name of the rectangle resource 
to edit. 
If nothing or ‘Selected resource’ is selected for this 
element, the resource selected on the “Rectangle 
resource” pane is the target to edit. 

② Index You can select the rectangle information for editing. 

③ X-coordinate You can edit the x-coordinate of the upper left of 
the rectangle. 

④ Y-coordinate You can edit the y-coordinate of the upper left of 
the rectangle. 

⑤ Width You can edit the width of the rectangle. 

⑥ Height You can edit the height of the rectangle. 

⑦ Angle You can edit the angle of the rectangle. 

⑧ Preview Updates the display of the red frame in the image 
input area temporarily based on the values of No.3 
to 7. This allows you to check the position of the 
rectangle after editing. 

⑨ OK Confirms your edit.  

⑩ Cancel Cancels your edit.  

 

 

“Index” cannot be edited if the value for ”Rectangle resource name” meets any of the 

following conditions. 

• The selected resource contains no rectangle information. 

• The entered resource name does not exist. 

• Nothing or ‘Selected resource’ is selected for the element, and no resource or the 

resource that contains no rectangle information is selected on the “Rectangle 

resource” pane. 

 

 

“X-coordinate,” “Y-coordinate,” “Width,” “Height,” “Angle,” and “Preview” cannot be 

edited nor clicked if “Rectangle resource name” meets any of the following 

conditions. 

• “MAIN” is selected. 

• The selected resource contains no rectangle information. 
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• The entered resource name does not exist. 

• Nothing or ‘Selected resource’ is selected for the entry, and no resource, “MAIN,” 

or the resource that contains no rectangle information is selected on the 

“Rectangle resource” pane. 

 

 

Figure 3-20. Image input area showing the target for editing 
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3.3.5 Editing/viewing a coordinate resource 

 

 

Figure 3-21. Editing a coordinate resource on the image input area 

With one or more coordinate resources registered, right-click on an image resource 
to display the menu (Figure 3-21). 

Click "Edit/View coordinates information" in the displayed menu to open the 
"Edit/View coordinates information" window (Figure 3-22). 
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Figure 3-22. "Edit/View coordinates information" window 

 

In the "Edit/View coordinates information" window, you can edit the coordinates 
information of the coordinate resource for each parameter. The coordinates 
information of the selected "Index" is displayed as a thick red line on the image input 
area (Figure 3-23). 

 

Table 3-5. "Edit/View coordinates information" window elements 

No. Element Description 

① Coordinate resource name You can select the name of the coordinate resource 
for editing. 
If nothing or ‘Selected resource’ is selected for this 
element, the resource selected on the “Coordinate 
resource” pane is the target to edit 

② Index You can select the rectangle information for editing. 

③ X-coordinate You can edit the x-coordinate. 

④ Y-coordinate You can edit the y-coordinate. 

⑤ Preview Updates the display of the red circle in the image 
input area temporarily based on the values of No.3 
and 4. This allows you to check the position of the 
coordinates after editing. 

⑥ OK Confirms your edit.  

⑦ Cancel Cancels your edit.  

 

 

“Index” cannot be edited if the value for “Coordinate resource name” meets any of the 

following conditions. 

• The selected resource contains no coordinates information. 
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• The entered resource name does not exist. 

• Nothing or ‘Selected resource’ is selected for the element, and no resource or the 

resource that contains no coordinates information is selected on the “Coordinate 

resource” pane. 

 

 

“X-coordinate,” “Y-coordinate,” and “Preview” cannot be edited nor clicked if 

“Coordinate resource name” meets any of the following conditions. 

• “MAIN” is selected. 

• The selected resource contains no coordinates information. 

• The entered resource name does not exist. 

• Nothing or ‘Selected resource’ is selected for the entry, and no resource, “MAIN,” 

or the resource that contains no coordinates information is selected on the 

“Coordinate resource” pane. 

 

 

Figure 3-23. Image input area showing the target for editing 
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3.3.6  Changing the zoom level 

After registering an image resource, you can change the zoom level of the image 

input area by clicking the image input area and then scrolling the mouse wheel while 

holding down the ‘Ctrl’ key. 

You can also increase the zoom level by pressing the ‘+’ key while holding down 

the ‘Ctrl’ key, and decrease the zoom level by pressing the ‘-‘ key while holding down 

the ‘Ctrl’ key. 
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4  Input 

  Input menu 
The Input menu has functions for inputting image data from a file, the clipboard, or 

by a snapshot. You can register the input image information as an image resource 
and display the image in the image input area of WinActorEye.  

Click "Input" on the menu bar to display its functions as shown in "Figure 4-1. Input 
menu" below. 

 

  
 

Figure 4-1. Input menu 

 

Table 4-1. Input menu 

No. Function Description 

1 Input image Displays the "Input image" window. 
For details, see "4.2 Input image." 

2 Snapshot Displays the "Snapshot" window. 
For details, see "4.3 Snapshot." 
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  Input image 
"Input image" is a function to input image data from a file or the clipboard. 
 

 

    When "from File" is selected           When "from Clipboard" is selected 
  

Figure 4-2. "Input image" window 
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4.2.1  from File 
"Figure 4-3. "Input image" window (from File)" shows a window to be displayed 

when you select "from File" as a method of inputting image data in the Input image 
window. 

 

 

Figure 4-3. "Input image" window (from File) 

 
The operation procedure to input image data from a file is as follows. 
 

① Select "from File" as a method of inputting image data. 
 

② Click the "Browse file" button (②-1) and specify where to reference a file. The 
file path name of the referenced location will be automatically entered in the file 
path field (②-2). You can also manually edit the text in the file path field (②-2). 

 

③ Check the box to set the input image to the selected state.  
 

④ Check the box to not record the work folder change when recording a macro. 
When unchecked (set to record), a macro that changes the work folder to the 
reference destination specified in ②-2 will be automatically generated. If you 
do not want to change the work folder, check the box (set to not record). 

 

⑤ Specify an image resource name. It can be omitted. If omitted, the image file 
name specified in the file path field (②-2) will be the image resource name. 

 

⑥ Click the button to input the image data based on the settings made in ① to ⑤. 
If "Select the image" is checked in ③, the input image will be displayed in the 
image input area. 
Image information will be registered or updated as an image resource. If the 
specified resource name already exists, the image information of the image 
resource will be overwritten and updated. 
If the resource name does not exist, it will be newly registered. 
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“Do not record the work-folder change into macro.” is complemented below.  

File input/output functions such as ‘Input tool’ of WinActor Note and ‘Input image’ of 

WinActorEye have the setting “Do not record the work-folder change into macro.” 

This setting specifies whether a movement of work folder is recorded in the macro 

created with the macro recording.  

An example of ‘Input image’ of WinActorEye is described below.  

 

 

• [Checked] Do not record the work folder change into macro. 

The recorded macro does not have the row of changing the work folder. 

 

As the default work folder is the folder for saving scenarios, the image files input 

to WinActorEye are supposed to be stored in the folder.  

Storing scenarios file and their accompanying files in a folder, you can easily 

copy them by just copying the folder to another computer, and use them without 

correcting the file paths specified in the macros in them.  
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• [Not checked] Do record the work folder change into macro. 

The recorded macro has the row of changing the work folder. 

 

Image files are supposed to be gathered in the folder different from the folder for 

saving scenario files. 

Saving scenario files and accompanying files in separate folders, you can easily 

move the folder for scenarios. 

  

 

 

When the ‘Call scenario file’ node or a subscenario is executed in a scenario, the work 

folder is changed to the file path of the called or executed scenario file.  

To execute WinActorEye libraries properly after such call or execution in the scenario, 

place the ‘Eye_SetWorkFolder’ library before the WinActorEye libraries and specify 

‘Scenario_folder’ for ‘Specify_the_folder’ property, or place the 

‘Eye_ReadAndRunMacro’ library before the WinActorEye libraries and change the 

work folder back in the macro file specified in it.  
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4.2.2 from Clipboard 
"Figure 4-4. “ "Input image" window (from Clipboard)" shows a window to be 

displayed when you select "from Clipboard" as a method of inputting image data in 
the Input image window. 

 

 

Figure 4-4. "Input image" window (from Clipboard) 

 
The operation procedure to input image data from the clipboard is as follows. 
 

① Select "from Clipboard" as a method of inputting image data. 
 

② Check the box to set the input image to the selected state. 
 

③ Specify an image resource name. It can be omitted. If omitted, the image 
resource name will be "clipboard." 

 

④ Click the button to input the image data based on the settings made in ① to ③. 
When "Select the image " is checked in ②, the input image will be displayed in 
the image input area. 
Image information will be registered or updated as an image resource. If the 
specified resource name already exists, the image information of the image 
resource will be overwritten and updated. 
If the resource name does not exist, it will be newly registered. 
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  Snapshot 
"Snapshot" is a function to input image data by specifying an image to be input with 

a mouse click or by specifying a window title name. 
 

 

When "Click to specify" is selected           When "Specify window title name" is selected 

 
Figure 4-5. "Snapshot" window 

 

Depending on your environment and target application, it may be acquired in an 

inactive state. When you run a macro including the snapshot function using the 

"Eye_ReadAndRunMacro" library, place the "Window_BringWindowToTop" and "Wait 

for Time" nodes immediately above the "Eye_ReadAndRunMacro" library in the 

flowchart area of WinActor, and it may improve the deactivation.  

 

・ Window_BringWindowToTop Library: 11_Window/Window_BringWindowToTop* 

・ Wait for Time   Node: Action / Wait for Time* 

 

* For details on the user libraries and nodes, see "WinActor User Library Sample 

Manual" and "WinActor Operation Manual." 
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4.3.1  Drop shadow 
The shadow around the application window as shown in Figure 4-6 is called a drop 

shadow in this function. 
In "Snapshot", you can select the presence or absence of the drop shadow when 

inputting image data. 
 

 

Figure 4-6. Drop shadow (shadow between the application window and the red frame) 

 
Set the drop shadow when performing a mouse action on a matched location using 

the user libraries. 
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4.3.2  Click to specify 
"Figure 4-7. 'Figure 4-7. "Snapshot" window (Click to specify)" shows a window to 

be displayed when you select "Click to specify" as a method of inputting image data 
in the Snapshot window. 

 

 

Figure 4-7. "Snapshot" window (Click to specify) 

 
The operation procedure to specify image data by clicking is as follows. 
 

① Select "Click to specify" as a method of inputting image data. 
 

② Click the "Select target window" button (②-1) and specify a target application 
widow by clicking it. The acquired window title name will be automatically 
entered in the window title field (②-2). You can also manually edit the text in 
the window title field (②-2). When targeting the entire desktop, leave ②-2 
blank.  

 

③ Specify an image resource name. It can be omitted. If omitted, the window title 
specified in ②-2 will be the image resource name. 
 

④ Check the box to set the input image to the selected state.  
 

⑤ Check the box to input the image data without the drop shadow. 
 

⑥ Click the button to input the image data based on the settings made in ① to 
⑤. 
When "Select the image " is checked in ④, the input image will be displayed in 
the image input area.  
Image information will be registered or updated as an image resource. If the 
specified resource name already exists, the image information of the image 
resource will be overwritten and updated. 
If the resource name does not exist, it will be newly registered. 
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4.3.3  Specify window title name 
"Figure 4-8. "Snapshot" window (Specify window title name)" shows a window to 
be displayed when you select "Specify window title name" as a method of inputting 
image data in the Snapshot window. 

 

 

Figure 4-8. "Snapshot" window (Specify window title name) 

 
The operation procedure to specify image data by a window title name is as 

follows. 
 

① Select "Specify window title name" as a method of inputting image data.  
 

② Specify a window title of a target application window. 
When targeting the entire desktop, leave ② blank. 

 

③ Select "Match" or "Include" for the condition for the window title specified in ②. 

 

④ Specify an image resource name. It can be omitted. If omitted, the window title 
specified in ② will be the image resource name. 
 

⑤ Check the box to set the input image to the selected state. 
 

⑥ Check the box to input the image data without the drop shadow. 
 

⑦ Click the button to input the image data based on the settings made in ① to ⑥. 
When "Select the image" is checked in ⑤, the input image will be displayed in 
the image input area. 
Image information will be registered or updated as an image resource. If the 
specified resource name already exists, the image information of the image 
resource will be overwritten and updated. 
If the resource name does not exist, it will be newly registered. 
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5  Output 

  Output menu 
The Output menu has a function for outputting an image resource created/edited 

on WinActorEye to a file or the clipboard.  
Click "Output" on the menu bar to display its function as shown in "Figure 5-1" 

below. 
 

  

Figure 5-1. Output menu 

 

Table 5-1. Output menu 

No. Function Description 

1 Output image Displays the "Output image" window. 
For details, see "5.2 Output image."  
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  Output image 
"Output image" is a function to output image data to a file or the clipboard. 

 

 
When "to File" is selected 

 

 
When "to Clipboard" is selected 

 

Figure 5-2. "Output image" window 
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5.2.1  to File 
"Figure 5-3. "Output image" window (to File)" shows a window to be displayed 

when you select "to File" as a method of outputting image data in the Output image 
window. 

 

 

Figure 5-3. "Output image" window (to File) 

The operation procedure to output image data to a file is as follows. 
 

① Select an image resource name from the drop-down list or specify it manually. 
It can be omitted. If omitted, the resource being selected in the "Image 
resource" pane will be specified.  
 

② Select "to File" as a method of outputting the image data. 
 

③ Select an output file format. The image format can be selected from "PNG file," 
"JPG file," and "BMP file." 

 

④ Check the box to adjust the image type (bit depth) automatically. When 
checked, the image type according to the image format in ③ will be output. 

 

⑤ Click the "Browse file" button (⑤-1) and specify where to reference a file. The 
file path name of the referenced location will be automatically entered in the file 
path field (⑤-2). You can also manually edit the file path field (⑤-2). The file 
path extension will be the image file format selected in ③. 

 

⑥ Check the box to not record the work folder change when recording a macro. 
When unchecked (set to record), a macro that changes the work folder to the 
reference destination specified in ⑤-2 will be automatically generated. If you 
do not want to change the work folder, check the box (set to not record). 

 

⑦ Click the button to output the image data based on the settings made in ① to 
⑥. If the file name specified in the file path field (⑤-2) already exists, the file 
will be overwritten and updated.  
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5.2.2  to Clipboard 
"Figure 5-4. "Output image" window (to Clipboard)" shows a window to be 

displayed when you select "to Clipboard" as a method of outputting image data in the 
Output image window. 

 

 

Figure 5-4. "Output image" window (to Clipboard) 

 
The operation procedure to output image data to the clipboard is as follows. 
 

① Select an image resource name from the drop-down list or specify it manually. 
It can be omitted. If omitted, the resource being selected in the "Image 
resource" pane will be specified.  
 

② Select "to Clipboard" as a method of outputting the image data.  
 

③ Check the box to adjust the image type (bit depth) automatically. 
 

④ Click the button to output the image data based on the settings made in ① to 
③. 
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6  Edit image 

  Edit image menu 
The Edit image menu has a function for editing and processing an image resource.  
Click "Edit image" on the menu bar to display its function as shown in "Figure 6-1. 

Edit image menu" below. 
 

  

Figure 6-1. Edit image menu 

 

Table 6-1. Edit image menu 

No. Function Description 

1 Trim Displays the "Trim" window. 
For details, see "6.2 Trim." 
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  Trim 
"Trim" is a function to cut out an image resource input by the Input function.  
 
To perform trimming operation, specify an area to be cut out by dragging on the 

image input area. 
 

 

      Before selecting the area                 After selecting the area 
 

Figure 6-2. Selecting the trimming area 
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The elements of the "Trim" window are as shown in "Figure 6-3. "Trim" window." 
 

 

Figure 6-3. "Trim" window 

 
The operation procedure of the "Trim" window is as follows. 
 

① Select an image resource name before trim from the drop-down list or specify it 
manually. If unselected or not entered (null character), the resource being 
selected in the "Image resource" pane will be specified. 

 

② Select a rectangle resource name before trim from the drop-down list or specify 
it manually. If unselected or not entered (null character), the resource being 
selected in the "Rectangle resource" pane will be specified.  

 

③ Select an image resource name after trim from the drop-down list or specify it 
manually. If unselected or not entered (null character), it will be registered in the 
image resource specified in the "Image resource name" before trim in ①.  

 

④ Check the box to set the trimmed image to the selected state. (The image will 
be displayed in the image input area.) 

 

⑤ Click the button to edit the image to cut out the image within the rectangle 
resource (red frame) based on the settings made in ① to ④. Image 
information will be registered or updated as an image resource.  
If the resource name specified in the image resource name after trim in ③ 
already exists, the image information of the image resource will be overwritten 
and updated. If the resource name does not exist, it will be newly registered. 
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             Before trim                            After trim 
 

Figure 6-4. Example of editing the image using Trim 
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7  Filter 

  Filter menu 
The Filter menu has functions for getting information from an image resource or 

rectangle resource and for converting a resource into a different resource. 
Click "Filter" on the menu bar to display its functions as shown in "Figure 7-1. Filter 

menu" below. 
 

  

Figure 7-1. Filter menu 
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Table 7-1. Filter menu 

No. Action Function Description 

1 

Matching 

Histogram search Displays the "Histogram search" window. 
For details, see "7.3 Histogram search." 

2 Detect rectangles Displays the "Detect rectangles" window. 
For details, see "7.4 Detect rectangles 

3 Detect circles Displays the "Detect circles" window. 
For details, see "7.5 Detect circles." 

4 Search specified color Displays the "Search specified color" window. 
For details, see "7.6 Search specified color." 

5 

Resource 

narrowing 

and 

conversion 

Boolean operation Displays the "Boolean operation" window. 
For details, see "7.7 Boolean operation 

6 Selection algorithm Displays the "Selection algorithm" window. 
For details, see "7.8 Selection algorithm 

7 Extract coordinates 

from rectangle 

Displays the "Extract coordinates from 
rectangle" window. 
For details, see "7.9Extract coordinates from 
rectangle 
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  Terms used in parameters 

This section describes the terms used as parameters for the filter functions. 

 

7.2.1  Number of pixels on a contour 

The number of pixels is the points that make up a contour of a target for matching. 

As shown in Figure 7-2. Example of the number of pixels on the contour, the number 

of pixels on the contour varies depending on the shapes even if the images have the 

same size.  

Image resources output by "Filter" that uses pixels on contours are composed of 

black and white as shown in Figure 7-13 and Figure 7-18. 

 

 

Figure 7-2. Example of the number of pixels on the contour 
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Figure 7-3. Checking the number of pixels on the contour of the rectangle 

  

You can adjust a rectangle resource output by "Filter" by adjusting the minimum 

and maximum values of pixels on the contour. 

The method of checking the number of pixels on the contour of a rectangle is as 

follows. 

 

① Register an image or a window that contains a target for matching in the image 

resource. 

For the registration method of an image resource, see "4 Input." 

 

② On the main window, drag and enclose a target for matching. 

 

③ Click "Rectangle resource" in the "View" menu to display the "Rectangle resource" 

pane.  

For the "Rectangle resource" pane, see "10.4 Rectangle resource." 
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④ Get the width and height of "MAIN" registered in the "Rectangle resource" pane. 

For details on rectangle information, see "Table 10-6. Items in the rectangle 

resource area. Items in the rectangle resource area." 

 

⑤ Approximate number of pixels on the contour can be calculated by calculating as 

shown in Figure 7-3 based on the width and height information acquired in ④. 
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7.2.2  Number of allowable vertices  

In "7.4 Detect rectangles," the number of contours and vertices of a target for 

matching are used to detect rectangles.  

In the case of a rectangle, the number of vertices is eight because it becomes as 

shown in Figure 7-4. However, it may actually have more than eight vertices even if it 

looks rectangle. In such a case, the detection can be performed by specifying the 

number of allowable vertices to be eight or more. 

For the number of vertices in other shapes, see "Figure 7-5. Example of the 

number of allowable vertices." Note that Figure 7-5. Example of the number of 

allowable vertices is for reference only and may not always be exactly as stated. 

Some figures such as circles have more or less vertices depending on the size of 

the image. 

 

Figure 7-4. Vertices when detecting a rectangle 

 

Figure 7-5. Example of the number of allowable vertices 
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7.2.3  Open and closed contours 

An open contour is a contour whose start and end points do not meet, such as 

"  ." 

A closed contour is a contour whose start and end points meet, such as "  ." 
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7.2.4  Roundness and level of correction 

In "7.5 Detect circles," "Roundness" and "Level of correction" are used to detect 

round-shaped areas. You can specify values for "Roundness" and "Level of 

correction" in the range of 1 to 5.  

For "Roundness," round objects can be detected when the value is increased, and 

square objects can be detected when the value is decreased. 

For "Level of correction," only perfect circles can be detected when the value is 

increased, and ellipses or small circles can be detected when the value is decreased.  

Figure 7-6 to Figure 7-9 are examples of parameter adjustments when you want to 

detect only perfect circles from the input image in which "perfect circles" and 

"non-round circles" are mixed. 

 

 

Figure 7-6. Input image 

 

 

Figure 7-7. Example 1 (Roundness: 3, Level of correction: 3) 
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Figure 7-8. Example 2 (Roundness: 5, Level of correction: 3) 

 

 

 

Figure 7-9. Example 3 (Roundness: 5, Level of correction: 5) 
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  Histogram search 
"Histogram search" is a function to search for areas on a reference base image 

resource that have a color similar to a reference image resource as shown in "Figure 
7-10. . Histogram search 

 

 

Figure 7-10. Histogram search 

 
Since this is a matching method that focuses on color information, it is less 

susceptible to the effect of display size than the existing Image Matching and Contour 
Matching.  
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Click "Histogram search" in the "Filter" menu to display the "Histogram search" 

window shown in Figure 7-11. 
 

 

Figure 7-11. "Histogram search" window 

 
The operation procedure of the "Histogram search" window is as follows. 
 

① Specify a base image resource name. 
 

② Specify a reference image resource name.  

 

③ Enter the minimum number of pixels on the contour. For the number of pixels 
on the contour, see "7.2.1 Number of pixels on a contour." A rectangle 
resource with the number of pixels on the contour larger than this number will 
be output.  

 

④ Enter the maximum number of pixels on the contour. For the number of pixels 
on the contour, see "7.2.1 Number of pixels on a contour." A rectangle 
resource with the number of pixels on the contour smaller than this number will 
be output. 

 

⑤ Set the matching rate. The larger the matching rate, the more accurately the 
target can be found. 

 

⑥ Specify an output image resource name. 

 

⑦ Specify an output rectangle resource name. 
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⑧ Set the timeout value. (The timeout time depends on the specifications of your 
computer.) 

 

⑨ Click the button to search for the areas that match the reference image 
resource on the base image resource based on the settings made in ① to ⑧. 

 

After executing, the areas that match the reference image will be displayed in white 
in the image input area as shown in Figure 7-13. If there is no matching area, only the 
black background will be displayed. 

 

 

Figure 7-12. Input image 
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Figure 7-13. Example of executing "Histogram search" 

 

Furthermore, by selecting the base image resource specified in the step ① after 

executing "Histogram search," you can check the result with the matching result 

overlaid on the base image resource as shown in Figure 7-14. 
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Figure 7-14. Example of executing "Histogram search" (with the rectangle resource 
overlaid on the base image resource) 
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  Detect rectangles 
"Detect rectangles" is a function to search for rectangles on a specified image 

resource. 
 

 

Figure 7-15. Detect rectangles 

 
This is a matching function suitable when the targets for matching are rectangles 

such as buttons. 
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Click "Detect rectangles" in the "Filter" menu to display the "Detect rectangles" 

window shown in Figure 7-16. 
 

 

Figure 7-16. "Detect rectangles" window 

 
The operation procedure of the "Detect rectangles" window is as follows. 
 

① Specify an input image resource name. 
 

② Enter the number of allowable vertices. For descriptions of the vertices, see 
"7.2.2 Number of allowable vertices." 

 

③ Select "Open contours only" or "Closed contours only." For descriptions of the 
contours, see "7.2.3contours." 

 

④ Enter the minimum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour larger than this 
number will be output. 

 

⑤ Enter the maximum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour smaller than this 
number will be output. 

 

⑥ Specify an output image resource name. 
 

⑦ Specify an output rectangle resource name. 
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⑧ Click the button to detect the rectangle information and register it in the image 
resource and in the rectangle resource based on the settings made in ① to ⑦. 

 
After executing, the detected rectangles will be displayed in white in the image 

input area as shown in Figure 7-18. If there is no rectangle detected, only the black 
background will be displayed. 

 

 

Figure 7-17. Input image 



 

64 

 

 

 

Figure 7-18. Example of executing "Detect rectangles" 
 

 

Furthermore, by selecting the image resource specified in the step ① after 

executing "Detect rectangles," you can check the result with the rectangle information 

overlaid on the input image resource as shown in Figure 7-19. 
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Figure 7-19. Example of executing "Detect rectangles" (with the rectangle 
information overlaid on the input image resource) 
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  Detect circles 
"Detect circles" is a function to search for "round-shaped areas" on a specified 

image resource. 
 

 

Figure 7-20. Detect circles 

 
This is a matching function suitable when the targets for matching have round 

shapes such as buttons. 
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Click "Detect circles" in the "Filter" menu to display the "Detect circles" window 

shown in Figure 7-21. "Detect circles" window 
 

 

Figure 7-21. "Detect circles" window 

 
The operation procedure of the "Detect circles" window is as follows.  
 

① Specify an input image resource name. 
 

② Specify a value of the roundness. For descriptions of the roundness, see "7.2.4 
Roundness and level of correction." 

 

③ Specify a value of the level of correction. For descriptions of the level of 
correction, see "7.2.4 Roundness and level of correction." 

 

④ Enter the minimum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour larger than this 
number will be output. 

 

⑤ Enter the maximum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour smaller than this 
number will be output. 

 

⑥ Specify an output image resource name. 
 

⑦ Specify an output rectangle resource name. 
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⑧ Click the button to detect the round-shaped areas and register them in the 
image resource and in the rectangle resource based on the settings made in 
① to ⑦.  

 
After executing, the detected round-shaped areas will be displayed in white in the 

image input area as shown in Figure 7-23. Example of executing "If there is no 
round-shaped area detected, only the black background will be displayed.  

 
 

 

Figure 7-22. Input image 

 

 

Figure 7-23. Example of executing "Detect circles" 
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Furthermore, by selecting the image resource specified in the step ① after 

executing "Detect circles," you can check the result with the rectangle information 

overlaid on the input image resource as shown in Figure 7-24. Example of executing 

"Detect circles" (with the rectangle information overlaid on the input image resource) 

 

 

Figure 7-24. Example of executing "Detect circles" (with the rectangle 
information overlaid on the input image resource) 
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 Search specified color 

"Search specified color" is a function to search for areas with a color similar to the 

specified color resource on a specified image resource. 

 

 

Figure 7-25. Search specified color 

 

This is a matching function suitable for objects with distinctive colors compared to 

the surroundings, such as icons and UI. 
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Click "Search specified color" in the "Filter" menu to display the "Search specified 

color" window shown in Figure 7-26. 

 

 

Figure 7-26. "Search specified color" window 

 

 The operation procedure of the "Search specified color" window is as follows.  

 Before using "Search specified color," it is necessary to register a color resource 

using "Color picker tool." 

 

① Specify a color system. The matching result may differ depending on the 
specified color system. 
 

Table 7-2. Color system options 

No. Color 
system 

Description 

1 RGB A color system commonly used on computers. 

2 HSV A color system that expresses colors by hue, saturation, and 
brightness (value). 
Compared to RGB, it is useful when comparing bright colors. 

3 Lab A color system close to human perception. 
Compared to RGB, it is possible to compare colors that are 
closer to human perception. 

4 YUV A color system expressed by brightness and two color 
differences. 
Compared to RGB, it is more robust to changes in 
brightness. 

 

② Specify an input image resource name. 
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③ Specify an input color resource name. 

 

④ Set the matching rate. The larger the matching rate, the more accurately the 

specified color can be found. 

 

⑤ Enter the minimum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour larger than this 
number will be output. 

 

⑥ Enter the maximum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour smaller than this 
number will be output. 

 

⑦ Specify an output image resource name. 

 

⑧ Specify an output rectangle resource name. 

 

⑨ Click the button to search the areas with the color similar to the specified color 
and register them in the image resource and in the rectangle resource based 
on the settings made in ① to ⑧. 

 

After executing, the areas with the color similar to the specified color will be 
displayed in white in the image input area as shown in Figure 7-29. If there is no area 
with the color similar to the specified color, only the black background will be 
displayed.  

 

 

Figure 7-27. Input image 
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Figure 7-28. Specified color 

 

 

Figure 7-29. Example of executing "Search specified color" 

 

Furthermore, by selecting the image resource specified in the step ① after 

executing "Search specified color," you can check the result with the rectangle 

information overlaid on the input image resource as shown in Figure 7-30.  
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Figure 7-30. Example of executing "Search specified color" (with the rectangle 
information overlaid on the input image resource) 
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  Boolean operation 
"Boolean operation" is a function to output a common area or an entire area of an 

image resource output by the "Filter" function as shown in Figure 7-31. 
 

 

Figure 7-31. Boolean operation 

 
Image resources consisting of black and white as shown in Figure 7-13 and 

Figure 7-18 are used as inputs, and a common white area or all white areas existing 
in two image resources will be acquired. It is mainly used to narrow down the 
matching results as shown in Figure 7-31. 
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Click "Boolean operation" in the "Filter" menu to display the "Boolean operation" 

window shown in Figure 7-32. 
 

 

Figure 7-32. "Boolean operation" window 

 
The operation procedure of the "Boolean operation" window is as follows. 
 

① Specify a name of the first input image resource. For the image resource to be 
specified here, specify a black and white image resource that has been output 
by the "Filter" function. 
 

② Specify a name of the second input image resource. For the image resource to 
be specified here, specify a black and white image resource that has been 
output by the "Filter" function.  
 

③ Set the calculation method to AND or OR. When AND is set, the area common 
to the two image resources will be acquired. When OR is set, the entire area of 
the two image resources will be acquired.  
 

④ Enter the minimum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour larger than this 
number will be output. 
 

⑤ Enter the maximum number of pixels on the contour. For descriptions of the 
number of pixels on the contour, see "7.2.1 Number of pixels on a contour." A 
rectangle resource with the number of pixels on the contour smaller than this 
number will be output. 
 

⑥ Specify an output image resource name. 
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⑦ Specify an output rectangle resource name. 
 

⑧ Click the button to detect the common white area or all white areas based on 
the settings made in ① to ⑦. 
 

For the input images ① and ② in Figure 7-33, Figure 7-34 shows an example of 

executing "Boolean operation" with AND set for the calculation method, and Figure 

7-35 shows an example of executing "Boolean operation" with OR set for the 

calculation method. 

If there is no common white area, only the black background will be displayed. 

 

 

Figure 7-33. Input images 

 

Figure 7-34. Example of executing "Boolean operation" (AND) 
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Figure 7-35. Example of executing "Boolean operation" (OR) 
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  Selection algorithm 
"Selection algorithm" is a function to narrow down rectangle information of a 

rectangle resource output by the "Filter" matching function. It is used to pick up a 
position for mouse action from a rectangle resource with information for multiple 
rectangles. 

Click "Selection algorithm" in the "Filter" menu to display the "Selection algorithm" 
window shown in Figure 7-36. The input item changes depending on the item 
selected in the drop-down list of the Selection algorithm field. 

 

 

Figure 7-36. "Selection algorithm" window 

 
Each of the following subsections describes the operation procedure with each 

item in the Selection algorithm drop-down list specified when executing "Selection 
algorithm" in the state shown in "Figure 7-37. Before executing "Selection algorithm." 
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Figure 7-37. Before executing "Selection algorithm" 
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7.8.1  Center of image 
"Center of image" is to select rectangle information whose center of the rectangle is 

closest to the center of a specified image resource. This is useful when a target of 
mouse action is near the center of a captured image.  

Figure 7-38 shows the "Selection algorithm" window when "Center of image" is 
selected. 

 

 

Figure 7-38. "Selection algorithm" window (Center of image) 

 
The operation procedure when "Center of image" is selected is as follows. 
 

① Specify a rectangle resource for executing "Selection algorithm."  
 

② Specify a base image resource. 
 

③ Specify a resource name for which rectangle information is to be output.  
 

④ Check the box to set the registered rectangle resource to the selected state. 
(The resource will be displayed in the image input area.)  

 

⑤ Click the button to execute and register the output rectangle information in the 
"Rectangle resource" pane based on the settings made in ① to ④. 
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Figure 7-39 shows the example of executing "Selection algorithm" with "Center of 

image" selected. The rectangle information in the center of the five pieces of 

rectangle information arranged in a cross is selected. 

 

 

Figure 7-39. Example of executing "Selection algorithm" (Center of image) 
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7.8.2  Uppermost/Lowermost/Leftmost/Rightmost 

"Uppermost," "Lowermost," "Leftmost," or "Rightmost" is to select rectangle 

information that exists at the uppermost, lowermost, leftmost, or rightmost of the 

rectangle information held by a rectangle resource. This is useful when a target of 

mouse action is on the edge of a captured image.  

 Figure 7-40 shows the "Selection algorithm" window when "Uppermost" is selected. 

The input items in the window will be the same when "Lowermost," "Leftmost," or 

"Rightmost" is selected. 

 

 

Figure 7-40. "Selection algorithm" window (Uppermost) 

 

The operation procedure when "Uppermost" is selected is as follows. The same 
operation procedure applies when "Lowermost," "Leftmost," or "Rightmost" is 
selected.  

 

① Specify a rectangle resource for executing "Selection algorithm." 
 

② Specify a resource name for which rectangle information is to be output. 
 

③ Check the box to set the registered rectangle resource to the selected state. 
(The resource will be displayed in the image input area.) 

 

④ Click the button to execute and register the output rectangle information in the 
"Rectangle resource" pane based on the settings made in ① to ③. 
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Figure 7-41 shows an example of executing "Selection algorithm" with "Uppermost" 

selected. The rectangle information at the uppermost of the five pieces of rectangle 

information arranged in a cross is selected. 

 

 

Figure 7-41. Example of executing "Selection algorithm" (Uppermost) 
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7.8.3  Largest/Smallest 

 "Largest" or "Smallest" is to select rectangle information with the largest or the 

smallest area in the rectangle information held by a rectangle resource. This is useful 

when a target of mouse action is the largest or the smallest area in a captured image. 

 Figure 7-42 shows the "Selection algorithm" window when "Largest" is selected. 

The input items in the window will be the same when "Smallest" is selected. 

 

 

Figure 7-42. "Selection algorithm" window (Largest) 

 

The operation procedure when "Largest" is selected is as follows. The same 
operation procedure applies when "Smallest" is selected.  

 

① Specify a rectangle resource for executing "Selection algorithm." 
 

② Specify a resource name for which rectangle information is to be output. 
 

③ Check the box to set the registered rectangle resource to the selected state. 
(The resource will be displayed in the image input area.)  

 

④ Click the button to execute and register the output rectangle information in the 
"Rectangle resource" pane based on the settings made in ① to ③. 
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Figure 7-43 shows an example of executing "Selection algorithm" with "Largest" 

selected. The rectangle information with the largest area in the five pieces of 

rectangle information arranged in a cross is selected. 

 

 

Figure 7-43. Example of executing "Selection algorithm" (Largest) 
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7.8.4  Rectangles within range 

"Rectangles within range" is to select rectangle information existing in a range 

specified by a rectangle resource for specifying a range. Unlike "7.8.1 Center of 

image," "7.8.2 Uppermost/Lowermost/Leftmost/Rightmost," and "7.8.3 

Largest/Smallest," all rectangle information existing in the specified range will be 

selected. This is useful when there are multiple targets for mouse action within a 

specific range. 

Figure 7-44 shows the "Selection algorithm" window when "Rectangles within range" 

is selected. 

 

 

Figure 7-44. "Selection algorithm" window (Rectangles within range) 

 

The operation procedure when "Rectangles within range" is selected is as follows. 
 

① Specify a rectangle resource for executing "Selection algorithm." 
 

② Specify a rectangle resource for specifying a range. Figure 7-45 shows an 
example of registering a rectangle resource with three pieces of rectangle 
information vertically enclosed. For how to register a rectangle resource on the 
main window, see "3.3.2 Registering a rectangle resource." 

 

③ Specify a resource name for which the rectangle information is to be output. 
 

④ Check the box to set the registered rectangle resource to the selected state. 
(The resource will be displayed in the image input area.) 

 

⑤ Click the button to execute and register the output rectangle information in the 
"Rectangle resource" pane based on the settings made in ① to ④. 
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Figure 7-45. Registering a rectangle resource for specifying a range 

 

Figure 7-46 shows an example of executing "Selection algorithm" with "Rectangles 

within range" selected. The three pieces of rectangle information arranged vertically 

in the five pieces of rectangle information arranged in a cross are selected. 

 

 

Figure 7-46. Example of executing "Selection algorithm" (Rectangles within range)  
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 Extract coordinates from rectangle 
"Extract coordinates from rectangle" is a function to extract coordinates of a 

specified extraction location in a specified rectangle resource and register the 
coordinate information in the "Coordinate resource" pane as shown in Figure 7-47. 

This is a required function for mouse actions to be performed when creating a 
WinActorEye macro as it is necessary to pass the coordinate information to WinActor 
as shown in "Figure 2-1. Relationship diagram between WinActorEye and WinActor. 
Relationship diagram between WinActorEye and WinActor." 
 

 

Figure 7-47. Extracting coordinates from the rectangle 
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Click "Extract coordinates from rectangle" in the "Filter" menu to display the 
"Extract coordinates from rectangle" window shown in Figure 7-48. 

 

 

Figure 7-48. "Extract coordinates from rectangle" window 

 
The operation procedure of the "Extract coordinates from rectangle" window is as 

follows. 
 

① Specify an input rectangle resource name. 

       

② Select an extraction point you want to extract coordinates from the rectangle 
information. For the selection items in the drop-down list of the extraction point 
field, see "Table 7-3. List of rectangle coordinates extraction points." 

 

③ Specify an output coordinate resource name.  
 

④ Check the box to set the registered coordinate resource to the selected state. 
(The resource will be displayed in the image input area.) 

 

⑤ Click the button to extract the coordinates and register the coordinate resource 

based on the settings made in ① to ④. 
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Table 7-3. List of rectangle coordinates extraction points 

No. Selection item Rectangle coordinates extraction point 

1 Center Extracts coordinates of the center of a rectangle. 
* If the center coordinates include a decimal point, the value 
with decimals truncated will be the extraction result. 
(Example: 14.5 -> 14) 

2 Upper left Extracts coordinates of the upper left corner of a rectangle. 

3 Lower left Extracts coordinates of the lower left corner of a rectangle.  

4 Upper right Extracts coordinates of the upper right corner of a rectangle. 

5 Lower right Extracts coordinates of the lower right corner of a rectangle. 
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8  Tool 

  Tool menu 
The Tool menu has functions for processing an image using various resources of 

WinActorEye.  
Click "Tool" on the menu bar to display its functions as shown in "Figure 8-1. Tool 

menu" below. 
 

 

  

Figure 8-1. Tool menu 

 

Table 8-1. Tool menu 

No. Function Description 

1 OCR tool Displays the "OCR tool" window. 
For details, see "8.2 OCR tool." 

2 Color picker tool Displays the "Color picker tool" window. 
For details, see "8.3 Color picker tool." 

3 Barcode tool Displays the "Barcode tool" window. 
For details, see "8.4 Barcode tool." 
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  OCR tool 
"OCR tool" is a function that calls an external OCR tool and gets character 

information and its rectangle information from an image. Click "OCR tool" in the "Tool" 
menu shown in Figure 8-1 to display the "OCR tool" window. 

 
 

 

Figure 8-2. "OCR tool" window 

 
The external OCR tool that can be selected with "OCR tool" is as follows.  
 

Table 8-2. Selectable external OCR tool 

No. External OCR tool Description 

1 Microsoft OCR For details, see "8.2.1 Microsoft OCR." 
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8.2.1 Microsoft OCR 
Microsoft OCR is available. Note that WinActorEye does not guarantee the 

operation because the character extraction accuracy and the accuracy of the 
rectangle information about the character position depend on Microsoft OCR.  

Therefore, this function is provided as a sample. 
For specific usage examples, see "WinActorEye Scenario Creation Manual." 
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8.2.1.1  "OCR tool" window operation procedure 

The operation procedure of the "OCR tool" window is as follows. 
 

 

Figure 8-3. "OCR tool" window 

 

① Specify an input image resource name. Characters and character position 
information will be acquired for the image specified here. 
 

② Check the box to adjust the image type (bit depth) automatically. 
 

③ Set the language of characters to be acquired by OCR. The descriptions in 
Table 8-3 are for reference only and may not apply in some cases.  

 

Table 8-3. Output language 

No. Selection item Description 

1 OS's first preferred 

language 

The language with the highest priority in the language 
settings of Windows will be the output language of OCR. 

2 English English will be the output language of OCR. 

3 Japanese Japanese will be the output language of OCR. 

* There are conditions for the specified language setting to be valid. See 
"8.2.1.2 Windows language settings and Microsoft OCR language." 
* When the output language of OCR is English, the characters arranged 
vertically will not be detected. 
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④ Select the OCR character extraction unit. The descriptions in Table 8-4 are for 
reference only and may not apply in some cases. 

 

Table 8-4. Character extraction unit 

No. Selection item Description 

1 Row・Column A character string that is grouped vertically or horizontally 
will be extracted. 

2 Letters・Words One character for Japanese and a grouped character string 
for English and numbers will be extracted.  

 
 

⑤ Specify an output rectangle resource name. The coordinate information of the 
rectangle surrounding each character or character string will be output to the 
rectangle resource specified here. 

 

⑥ Select an output destination of the character data extracted from the image. 
 

Table 8-5. Character data output destination 

No. Selection item Description 

1 Clipboard Character data will be output to the clipboard. 
For example, after running this tool, you can display the 
output characters by selecting [Edit] > [Paste] in Notepad. 
It will be the character data with line breaks in the unit of 
extracted characters and character strings.  

 

⑦ Set the timeout value. If the processing takes longer than the time specified 
here, the processing will be canceled. 
 

⑧ Click the button to extract the character information from the specified image 
and output the coordinate information surrounding the character to the 
specified rectangle resource based on the settings made in ① to ⑦. 
 
 

8.2.1.2  Windows language settings and Microsoft OCR language 

The following describes the case of Windows 11 English (United States) version as 
an example.  

If "Japanese" in Table 8-3 is selected and the Japanese language pack is not 
installed, the setting will be invalid (it will be processed in the OS first preferred 
language). To use "Japanese" as the language for Microsoft OCR, install the 
Japanese language pack in advance. 

When "OS first preferred language" in Table is selected, if English (United States) 
and Japanese are listed as the language settings in Windows, the language at the 
top of the list will be the OCR output language.  

For the actual operation of the Windows language settings, see the Windows 
manual.  



 

97 

 

 

 Color picker tool 
"Color picker tool" is a function for getting color information from specified 

coordinates on an image. This is used when registering a color resource required for 
the function that inputs color information. 

Click "Color picker tool" in the "Tool" menu (Figure 8-1) to display the "Color picker 
tool" window. 
 

 

Figure 8-4. "Color picker tool" window 

 

① Specify an input image resource name. 
 

② Specify an input coordinate resource name. Color information will be extracted 
based on the coordinate information specified here. 
 

③ Specify an output color resource name. The extracted color information will be 
output to the color resource specified here. 
 

④ Click the button to extract the color information from the specified position of the 
specified image and output as a color resource based on the settings made in ① 
to ③. 
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 Barcode tool 
"Barcode tool" provides a function to use ZXing, which reads and writes a QR code 

or barcode.  
The accuracy of reading and writing a QR code or barcode and the conformance to 

standards such as ISO or JIS depend on ZXing. 
Click "Barcode tool" in the "Tool" menu (Figure 8-1) to display the "Barcode tool" 

window. 
 

 

Figure 8-5. "Barcode tool" window 

 
You can switch between "Read" and "Write" by clicking ① in Figure 8-5. 
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QR codes and barcodes that can be read or written are as follows. When using a 
QR code or barcode written with this tool, make sure that it can be read correctly with 
this tool before using it. 

Table 8-6. Supported QR codes and barcodes 

Type Available characters Number of 
characters 

Remarks 

QR code (*1)(*3) (*1) You can specify 
a character 
encoding when 
writing 

Barcode EAN-8 Numbers (0 to 9) only 8 (*2) 

EAN-13 Numbers (0 to 9) only 13 (*2) 

ITF Numbers (0 to 9) only Up to 80, 
Even number 

- 

CODE39 ASCII characters (*3) Up to 80 (*4) - 

CODE93 ASCII characters (*3) Up to 80 (*5) - 

CODE128 ASCII characters (*3) Up to 80 - 

(*1) Use within the range that does not cause an error with this tool. 
(*2) For the first digit (right end), the function to automatically calculate and replace 

check digits is available when writing. 
(*3) Control characters (0x00 to 0x1F, 0x7F) cannot be used. 
(*4) This is the upper limit for strings consisting only of numbers (0 to 9), alphabets 

(A to Z), and symbols (-, ., SP). If you use ASCII characters other than the 
above, the upper limit will be lower.  

(*5) This is the upper limit for strings consisting only of numbers (0 to 9), alphabets 
(A to Z), and symbols (-, ., SP, $, /, +, %). If you use ASCII characters other 
than the above, the upper limit will be lower.  
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8.4.1 Read 
The operation procedure is as follows. To read, select "Read" in ① on the window 

shown in Figure 8-5. 
 

 

Figure 8-6. "Barcode tool" window (Read) 

① Specify an input image resource name. Character data will be read from a QR 
code or barcode for the image specified here. 
 

② Select an output destination of the character data extracted from the image. 

Table 8-7. Character data output destination 

No. Selection item Description 

1 Clipboard Character data will be output to the clipboard. 
For example, after running this tool, you can display the 
output characters by selecting [Edit] > [Paste] in Notepad. 

 

③ Set the timeout value. If the processing takes longer than the time specified 

here, the processing will be canceled. 

 

④ Click the button to output the character data from the specified image to the 

destination specified in ② based on the settings made in ① to ③. 
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8.4.2 Write 
To write a QR code or barcode, select "Write" in ① on the window shown in Figure 

8-5. Next, select "QRcode" or "Barcode" in ① on the window shown in Figure 8-7. 

 

 

Figure 8-7. "Barcode tool" window (Write) 
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8.4.2.1 QR code 

The operation procedure is as follows. To write a QR code, select "QRcode" in ① 
on the window shown in Figure 8-7. 

 

 

Figure 8-8. "Barcode tool" window (writing a QR code) 

① Specify a level at which data can be restored when a code cannot be read 
(Level of error correction). The larger the number, the more data can be 
restored, but the amount of data will increase accordingly. 
 

② Specify a character encoding of the QR code. 
 

③ Specify data to make the QR code. For valid input values, see Table 8-6. 
 

④ Specify "Image resource name" to which the QR code will be output. 
 

⑤ Set the timeout value. If the processing takes longer than the time specified 
here, the processing will be canceled. 
 

⑥ Click the button to output the QR code to the image resource specified in ④ 

based on the settings made in ① to ⑤.  
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8.4.2.2 Barcode 

The operation procedure is as follows. To write a barcode, select "Barcode" in ① 
on the window shown in Figure 8-7. 

 

 

Figure 8-9. "Barcode tool" window (writing a barcode) 

① Specify a type of the barcode to be created. 
 

② For data entered in ③, specify whether to use the function that automatically 
calculates and replaces check digits. For the types that can use this function, 
see Table 8-6. 
 

③ Specify data to make the barcode. For the data that can be specified, see 
Table 8-6. 
 

④ Specify "Image resource name" to which the barcode will be output. 
 

⑤ Set the timeout value. If the processing takes longer than the time specified 
here, the processing will be canceled. 
 

⑥ Click the button to output the barcode to the image resource specified in ④ 
based on the settings made in ① to ⑤.  

 

  



 

104 

 

 

 

9  Settings 

  Settings menu 
The Settings menu has functions for setting a background color of the image input 

area and for clearing resources. 
Click "Settings" on the menu bar to display its functions as shown in “Figure 9-1. 
Settings menu" below. 

 
 

  

Figure 9-1. Settings menu 

 

 

Table 9-1. Settings menu 

No. Function Description 

1 Specify background color  Displays the "Specify background color" window. 

For details, see "9.2 Specify background color." 

2 Clear all resources Clears all registered resources. 
For details, see "9.3 Clear all resources." 
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  Specify background color 
"Specify background color" is a function to specify a background color of the image 

input area of WinActorEye.  
The elements of the window for specifying a background color are as shown in 

"Figure 9-2. Window for specifying a background color." 
 

   

Figure 9-2. Window for specifying a background color 

 

Table 9-2. Window elements for specifying a background color 

No. Element Description 

① Basic colors Specify a background color from the color palette. 

② Custom colors Displays colors added by Define Custom Colors. 

③ Define Custom Colors You can create new custom colors. 

④ OK Confirms your edit.  

⑤ Cancel Cancels your edit.  
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To create a new color, click the Define Custom Colors button and specify the hue, 

saturation, luminosity, red, green, and blue. 
 

  

 

Figure 9-3. Creating a new custom color 

 

Table 9-3. Elements to define a custom color 

No. Element Description 

① Hue Adjust the hue of a color in the range of 0 to 239.  

② Sat Adjust the saturation of a color in the range of 0 to 240. 

③ Lum Adjust the luminosity of a color in the range of 0 to 240. 

④ Red Specify a value for Red in the range of 0 to 255. 

⑤ Green Specify a value for Green in the range of 0 to 255. 

⑥ Blue Specify a value for Blue in the range of 0 to 255. 

⑦ Add to Custom 
Colors 

Adds the created custom color to the display of custom 
colors. 
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  Clear all resources 
"Clear all resources" is a function to clear all resource information registered in 

WinActorEye. 
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10  View 

  View menu 
The View menu has functions to display each pane. 
Click "View" on the menu bar to display its functions as shown in "Figure 10-1. 

View menu" below. 
 

 

 

Figure 10-1. View menu 
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Table 10-1. View menu 

No. Function Description 

1 WinActorEye edit macro Displays the "Edit macro" pane. 
For details, see " WinActorEye edit macro." 

2 Image resource Displays the "Image resource" pane. 
For details, see" 10.3 Image resource." 

3 Rectangle resource Displays the "Rectangle resource" pane. 
For details, see "10.4 Rectangle resource." 

4 Coordinate resource Displays the "Coordinate resource" pane. 
For details, see "10.5 Coordinate resource." 

5 Color resource Displays the "Color resource" pane. 
For details, see "10.6 Color resource." 

6 Preview Displays the “Preview” pane. 
For details, see “10.7 Preview.” 

7 Save current layout Saves the current layout 

8 Restore layout Restores the saved layout. 

9 Restore initial layout Restores the default layout. 
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  WinActorEye edit macro 
"WinActorEye edit macro" has functions for editing a macro of WinActorEye. 
Click "WinActorEye edit macro" in the "View" menu or click the "Edit macro" tab in 

the resource area to display the "Edit macro" pane. 
The items of the "Edit macro" pane are as shown in "Figure 10-2. 'Edit macro' 

pane." 
 

  

 

Figure 10-2. "Edit macro" pane 

 
The recorded macro operations will be displayed in the macro area. 
 

Table 10-2. Items in the macro area 

No. Item Description 

1 No. This will be automatically assigned. 

2 Command Displays commands. It will be set automatically during macro 
recording. 

3 Parameters Displays parameters. It will be set automatically during macro 
recording. 

4 Error/Warning Displays warnings during macro recording or errors when 
running a macro.  

5 User memo It can be used as a memo field when performing maintenance. 
You can edit a memo by double-clicking or pressing the ‘F2’ 
key with the User memo field selected. 
It is blank in the initial state. 

 

 
For details on the "WinActorEye edit macro" functions, see "11 Macro." 
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  Image resource 
"Image resource" is a function to display image data and image information input 

by the Input function.  
Click "Image resource" in the "View" menu or click the "Image resource" tab in the 

resource area to display the "Image resource" pane. 
 
The items of the "Image resource" pane are as shown in "Figure 10-3. "Image 

resource" pane." 
 

  

  

Figure 10-3. "Image resource" pane 

 
The registered resource information will be displayed in the image resource area. 
 

Table 10-3. Items in the image resource area 

No. Item Description 

1 No. Registered image resources are numbered from "1" in 
chronological order. It will be automatically assigned.  

2 Image resource name Displays registered image resource names. 
You can edit a name by double-clicking or pressing the 
‘F2’ key with the Image resource name field selected.  

3 Size Displays image size (width x height). 

4 Image type "RGB" (color, no transparency), "RGB/A" (color, 
transparency), "GRAY" (black and white), or "W/B" 
(white/black) type will be automatically identified and set 
as the image type. If there is no applicable type, 
"Unknown" will be displayed. 

5 User memo It can be used as a memo field when performing 
maintenance. 
You can edit a memo by double-clicking or pressing the 
‘F2’ key with the User memo field selected. 
It is blank in the initial state. 
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On the menu bar, there are menus for executing each function. 
You can input an image from a file, the clipboard, or by a snapshot using the "Input" 

menu. 
 

  

  

Figure 10-4. "Image resource" pane (Input menu) 

 
 

Table 10-4. Image resource (Input menu) 

No. Function Description 

1 Input image Inputs an image from a file or the clipboard. 
For details, see "4.2 Input image." 

2 Snapshot Inputs an image using a snapshot. 
For details, see "4.3 Snapshot." 
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You can output an image using the "Output" menu. 
 

  

  

Figure 10-5. "Image resource" pane (Output menu) 

 
For details on the "Output image" function, see "5.2 Output image." 
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You can copy registered image resources or delete unnecessary parts by using the 

"Edit" menu. 
 

  

  

Figure 10-6. "Image resource" pane (Edit menu) 

 
 

Table 10-5. Image resource (Edit menu) 

No. Function Keyboard Description 

1 Copy ‘Ctrl’ + ‘C’ key Copies selected resources. 

2 Paste ‘Ctrl’ + ‘V’ key Pastes copied resources. 
If a copied image resource name already exists 
when pasting, the image resource name will be 
registered with the copied image resource name 
with "_copy_" and a number at the end.  
Example) Copied image resource name_copy_1 
If the numbers are duplicated, the resource name 
will be registered with the number moved up by 1. 
Example) Copied image resource name_copy_2 

3 Delete ‘Delete’ key Deletes selected resources. 

4 Clear  Clears all registered resources. 
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  Rectangle resource 
The "Rectangle resource" pane displays registered rectangle resources.  
Click "Rectangle resource" in the "View" menu or click the "Rectangle resource" 

tab in the resource area to display the "Rectangle resource" pane. 
A rectangle resource will be registered by executing the "7.4  Detect rectangles" 

function or by using methods such as dragging the mouse over a target on an image 
resource displayed in the image input area. 

The rectangle information created by dragging (x-coordinate at the upper left of the 
rectangle [x], y-coordinate at the upper left of the rectangle [y], width of the rectangle 
[w], height of the rectangle [h], angle of the rectangle [a]) will all be registered on the 
rectangle resource named "MAIN." The user memo and rectangle information of 
"MAIN" cannot be edited. 

The items in the "Rectangle resource" pane are as shown in "Figure 10-7. 
"Rectangle resource" pane 

  

 

Figure 10-7. "Rectangle resource" pane 

 
The registered resource information will be displayed in the rectangle resource 

area. 
 

Table 10-6. Items in the rectangle resource area 

No. Item Description 

1 No. Registered rectangle resources are numbered from "1" in 
chronological order. It will be automatically assigned.  

2 Rectangle resource 

name 

Displays registered rectangle resource names. 
You can edit a name by double-clicking or pressing the 
‘F2’ key with the Rectangle resource name field selected. 

3 Number of rectangles Displays the number of rectangles detected. 
If the number of rectangles is zero, it will be blank. 

4 Rectangle information Displays detected rectangle information. 
Displays [x,y,w,h,a] for the information on one rectangle. 
Example) [10,20,50,60,0] 
For the information on multiple rectangles, displays the 
information by separating with ",". 
Example) 
[10,20,50,60,70],[20,30,40,50,60],[30,40,50,60,70] 
If there is no rectangle information, it will be blank. 

5 User memo It can be used as a memo field when performing 
maintenance. 
You can edit a memo by double-clicking or pressing the 
‘F2’ key with the User memo field selected. 
It is blank in the initial state. 
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You can copy registered rectangle resources, delete unnecessary parts, or call the 
"Edit rectangle resource" window by using the "Edit" menu. 

 

 

Figure 10-8. "Rectangle resource" pane (Edit menu) 

 
 

Table 10-7. Rectangle resource (Edit menu) 

No. Function Keyboard Description 

1 Copy ‘Ctrl’ + ‘C’ key Copies selected resources. 

2 Paste ‘Ctrl’ + ‘V’ key Pastes copied resources. 
If a copied rectangle resource name already 
exists when pasting, the rectangle resource 
name will be registered with the copied rectangle 
resource name with "_copy_" and a number at 
the end.  
Example) Copied rectangle resource 
name_copy_1 
If the numbers are duplicated, the resource name 
will be registered with the number moved up by 1. 
Example) Copied rectangle resource 
name_copy_2 

3 Delete ‘Delete’ key Deletes selected resources. 
"MAIN" cannot be deleted. 

4 Clear  Clears all registered resources. 

5 Edit/View 

rectangle 

resource 

‘Enter’ key Shows a selected resource in the "Edit rectangle 
resource" window. 
When "MAIN" is selected, the "View rectangle 
resource" window will be displayed. You cannot 
edit the resource in this window. 
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In the "Edit rectangle resource" window, you can edit parameters of "Rectangle 

resource name," "User memo," and "Rectangle information" for the selected 
rectangle resource. 

 
 

 

Figure 10-9. "Edit rectangle resource" window 
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Table 10-8. "Edit rectangle resource" window elements 

No. Element Description 

① Rectangle resource name Shows the registered rectangle resource name. 
You can edit it by clicking its input field. 

② User memo Shows the registered user memo. 
It can be used as a memo field when performing 
maintenance. 
You can edit it by clicking its input field. 

③ Add above Adds [x,y,w,h,a] above the selected rectangle 
information with all 0s ([0,0,0,0,0]). 
If not selected, it will be added at the top.  

④ Add below Adds [x,y,w,h,a] below the selected rectangle 
information with all 0s ([0,0,0,0,0]). 
If not selected, it will be added at the bottom. 

⑤ Delete Deletes the selected rectangle information. 

⑥ Rectangle information Shows the rectangle information being edited. 
You can edit the information by double-clicking or 
pressing the ‘F2’ key with the rectangle information 
selected.  
If it is not in [x,y,w,h,a] format, it returns to the 
previous value. 

⑦ OK Confirms your edit. 

⑧ Cancel Cancels your edit. 
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  Coordinate resource 
The "Coordinate resource" pane displays registered coordinate resources. Click 

"Coordinate resource" in the "View" menu or click the "Coordinate resource" tab in 
the resource area to display the "Coordinate resource" pane. A coordinate resource 
will be registered by executing the "7.9 Extract coordinates from rectangle" function 
or by using methods such as clicking a target on an image resource displayed in the 
image input area. 

The coordinate information created by clicking (center coordinate of "○" displayed 
in the image input area: x-coordinate [x], y-coordinate [y]) will all be registered on the 
coordinate resource named "MAIN." The user memo and coordinate information of 
"MAIN" cannot be edited.  

The items in the "Coordinate resource" pane are as shown in "Figure 10-10. 
"Coordinate resource" pane" 

  

  

Figure 10-10. "Coordinate resource" pane 

 
The registered resource information will be displayed in the coordinate resource 

area. 
 

Table 10-9. Items in the coordinate resource area 

No. Item Description 

1 No. Registered coordinate resources are numbered from "1" 
in chronological order. It will be automatically assigned.  

2 Coordinate resource 

name 

Displays registered coordinate resource names. 
You can edit a name by double-clicking or pressing the 
‘F2’ key with the Coordinate resource name field 
selected. 

3 Number of coordinates Displays the number of coordinates. 

4 Information of 

coordinates 

Displays detected information of coordinates. 
Displays [x,y] for the information on one coordinates. 
Example) [10,20] 
For the information on multiple coordinates, displays the 
information by separating with ",". 
Example) [10,20],[20,30],[30,40],[40,50] 
If there is no information of coordinates, it will be blank. 

5 User memo It can be used as a memo field when performing 
maintenance. 
You can edit a memo by double-clicking or pressing the 
‘F2’ key with the User memo field selected. 
It is blank in the initial state. 
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You can copy registered coordinate resources, delete unnecessary parts, or call 

the "Edit coordinate resource" window by using the "Edit" menu. 
 

  

Figure 10-11. "Coordinate resource" pane (Edit menu)  

 
 

Table 10-10. Coordinate resource (Edit menu) 

No. Function Keyboard Description 

1 Copy ‘Ctrl’ + ‘C’ key Copies selected resources. 

2 Paste ‘Ctrl’ + ‘V’ key Pastes copied resources. 
If a copied coordinate resource name already exists 
when pasting, the coordinate resource name will be 
registered with the copied coordinate resource name 
with "_copy_" and a number at the end.  
Example) Copied coordinate resource name_copy_1 
If the numbers are duplicated, the resource name will 
be registered with the number moved up by 1. 
Example) Copied coordinate resource name_copy_2 

3 Delete ‘Delete’ key Deletes selected resources. 
"MAIN" cannot be deleted. 

4 Clear  Clears all registered resources. 

5 Edit/View 

Coordinate 

Resource 

‘Enter’ key Shows a selected resource in the "Edit coordinate 
resource" window. 
When "MAIN" is selected, the "View coordinate 
resource" window will be displayed. You cannot edit 
the resource in this window. 

 

  



 

121 

 

 

 
In the "Edit coordinate resource" window, you can edit parameters of "Coordinate 

resource name," "User memo," and "Information of coordinates" for the selected 
coordinate resource. 

 
 

 

Figure 10-12. "Edit coordinate resource" window 
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Table 10-11. "Edit coordinate resource" window elements 

No. Element Description 

① Coordinate resource name Shows the registered coordinate resource name. 
You can edit it by clicking its input field. 

② User memo Shows the registered user memo. 
It can be used as a memo field when performing 
maintenance. 
You can edit it by clicking its input field. 

③ Add above Adds [x,y] above the selected coordinate 
information with all 0s ([0,0]). 
If not selected, it will be added at the top. 

④ Add below Adds [x,y] below the selected coordinate 
information with all 0s ([0,0]). 
If not selected, it will be added at the bottom. 

⑤ Delete Deletes the selected coordinate information. 

⑥ Information of coordinates Shows the information of coordinates being 
edited. 
You can edit the information by double-clicking or 
pressing the ‘F2’ key with the coordinate 
information selected.  
If it is not in [x,y] format, it returns to the previous 
value. 

⑦ OK Confirms your edit. 

⑧ Cancel Cancels your edit. 
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 Color resource 
The "Color resource" pane displays color resources and allows you to edit those 

resources. By specifying a color resource as an input item of "Search specified color," 
it is possible to search by specifying a color. 

Click "Color resource" in the "View" menu or click the "Color resource" tab in the 
resource area to display the "Color resource" pane. 

The items in the "Color resource" pane are as shown in "Figure 10-13. "Color 
resource" pane." 

 
  

 

Figure 10-13. "Color resource" pane 

 
The registered resource information will be displayed in the color resource area. 
 

Table 10-12. Items in the color resource area 

No. Item Description 

1 No. Registered color resources are numbered from "1" in 
chronological order. It will be automatically assigned. 

2 Color resource name Displays registered color resource names. 
You can edit a name by double-clicking or pressing the 
‘F2’ key with the Color resource name field selected. 

3 Palette Displays images of registered color information 
[RGBA]. 

4 Color information [RGBA] Displays detected color information in RGBA ([Red, 
Green, Blue, Alpha). 
You can edit information by double-clicking or pressing 
the ‘F2’ key with the Color information [RGBA] field 
selected. 

5 User memo It can be used as a memo field when performing 
maintenance. 
You can edit a memo by double-clicking or pressing 
the ‘F2’ key with the User memo field selected. 
It is blank in the initial state. 
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You can register new color resources, copy registered color resources, or delete 

unnecessary parts by using the "Edit" menu. 
 

  

Figure 10-14. "Color resource" pane (Edit menu) 

 
 

Table 10-13. Color resource (Edit menu) 

No. Function Keyboard Description 

1 New color  Creates a new color resource. 
The color information [RGBA] of the new color 
resource is [0,0,0,255]. 
The color resource name of the new color 
resource is “New color resource.” 
If the “New color resource” preexists, a sequence 
number is appended to the resource name. 
Example) “New color resource_1” 
If the resource name of the same sequence 
number preexists, the sequence number will be 
incremented by one.  
Example) “New color resource_2” 

2 Copy ‘Ctrl’ + ‘C’ key Copies selected resources. 

3 Paste ‘Ctrl’ + ‘V’ key Pastes copied resources. 
If a copied color resource name already exists 
when pasting, the color resource name will be 
registered with the copied color resource name 
with "_copy_" and a number at the end.  
Example) Copied color resource name_copy_1 
If the numbers are duplicated, the resource name 
will be registered with the number moved up by 1. 
Example) Copied color resource name_copy_2 

4 Delete ‘Delete’ key Deletes selected resources. 

5 Clear  Clears all registered resources. 
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 Preview 
The "Preview" pane displays the input resource which is specified in the property 

area of the selected function, and its resource information. Click ”Preview” in the 
“View” menu to display the “Preview” pane. 

The items in the "Preview" pane are as shown in "Figure 10-15. "Preview " pane.  
 

  

  

Figure 10-15. "Preview " pane 

 
 

Table 10-14. Items in the preview area 

No. Item Description 

1 Target function name Shows the function name of the target function. 

2 Main tab Displays the image, rectangle, or coordinate resource 
which is specified as the input in the property area. 
Maximum and minimum number of pixels on the 
contour may also be displayed as rectangles of dotted 
lines based on the origin of the displayed image. 

3 Resource tab Shows various resource information. 
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The configuration of the preview area changes according to the selected function The 

items in the "Preview" area are as shown in "Table 10-15. Items in the preview area." 

For details of the Main tab, see “10.7.1 Main tab.” 

For details of the Resource tab, see “10.7.2 Resource tab (Image resource),” “10.7.3 

Resource tab (Rectangle resource),” “10.7.4 Resource tab (Coordinate resource),” 

and “10.7.5 Resource tab (Color resource).” 

 

Table 10-15. Items in the preview area 

Function name Items in the preview area 

Output image Main tab (*) 

Trim Main tab, Resource tab (Rectangle resource) 

Histogram search Main tab, Resource tab (Image resource) 

Detect rectangles Main tab (*) 

Detect circles Main tab (*) 

Search specified color Main tab, Resource tab (Color resource) 

Boolean operation Main tab, Resource tab (Image resource) 

Selection algorithm Main tab, Resource tab (Rectangle resource) 

Extract coordinates from rectangle Main tab, Resource tab (Rectangle resource) 

OCR tool Main tab (*) 

Color picker tool Main tab, Resource tab (Coordinate resource) 

Barcode tool Main tab (*) 

 (*) The “Main tab” only is displayed. The “Resource tab” is not displayed. 
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10.7.1 Main tab 

The main tab displays the Image resource, the rectangle resource, the coordinate 

resource, or the pixels on the contour. 

 

  

Figure 10-16 Main tab (“Rectangle resource” is specified as the input.) 

 

 

 

Figure 10-17 Main tab (“Coordinate resource” is specified as the input.) 
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Figure 10-18 Main tab (Pixels on the contoour are specified.)  

 

Table 10-16. Items in the main tab 

No. item Description 

1 Image resource Displays the image resource specified as the 
input resource.  

2 Rectangle resource Shows the rectangle resource by red lines if it 
is specified as the input resource.  

3 Coordinate resource Shows the coordinate resource by red circles if 
it is specified as the input resource. 

4 Minimum number of pixels 

on the contour 

Shows the minimum number of pixels on the 
contour by dotted green lines if the minimum 
number of pixels on the contour is specified.  

5 Maximum number of pixels 

on the contour 

Shows the maximum number of pixels on the 
contour by dotted orange lines if the maximum 
number of pixels on the contour is specified.  

6 Fit to the preview window Changes zooming the displayed image. 
(See “10.7.6 Fit to the preview window”) 

7 Zoom level Displays the zooming level of the image. 
This is displayed only if the “Fil to the preview 
window” checkbox is unchecked.  
(See “10.7.6 Fit to the preview window”) 
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10.7.2 Resource tab (Image resource) 

The resource tab (Image resource) is displayed in the right half of the preview area 

when the second image resource that is specified in the property pane as the input 

resource exists. The resource tab (Image resource) itself displays the second image 

resource specified as the input resource. 

The pixels on the contour are not displayed in the resource tab (Image resource). 

 

 

 

Figure 10-19 Resource tab (Image resource)  

 

Table 10-17. Items in the resource tab (Image resource) 

No. item Description 

1 Image resource Displays the second image resource specified 
in the property pane as the input resource.  

2 Fit to the preview window Changes zooming behavior of the displayed 
image. 
(See “10.7.6 Fit to the preview window”) 

3 Zoom level Displays the zooming level of the image. 
This is displayed only if the checkbox “Fil to 
the preview window” is unchecked.  
(See “10.7.6 Fit to the preview window”) 
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10.7.3 Resource tab (Rectangle resource) 

The resource tab (Rectangle resource) is displayed in the right half of the preview 

area when a rectangle resource is specified in the property pane as the input 

resource. The resource tab (Rectangle resource) itself shows resource information of 

the rectangle resource specified in the property pane.  

 

 

 

Figure 10-20 Resource tab (Rectangle resource)  

 

Table 10-18. Items in the resource tab (Rectangle resource) 

No. item Description 

1 Rectangle resource name Shows the rectangle resource name specified 
as the input resource.  

2 Rectangle information Shows the rectangle information of the 
rectangle resource specified as the input 
resource.  

3 User memo Shows the user memo of the rectangle 
resource specified as the input resource.  
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10.7.3.1 The case two resource tabs (Rectangle resource) are displayed 

If two rectangle resources are specified in the property pane as input 

resource, two resource tabs (Rectangle resource) are displayed one upon the 

other.  

The overlapping resource tabs (Rectangle resource) can be switched by 

clicking the tabs. 

Both rectangle resources are displayed on the main tab, and the rectangle 

resource corresponding to the selected resource tab (Rectangle resource) is 

displayed in thick lines. (See “Figure 10-21 The case two resource tabs 

(Rectangle resource) are displayed.”) 

 

 

  

Figure 10-21 The case two resource tabs (Rectangle resource) are displayed. 
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10.7.4 Resource tab (Coordinate resource) 

The resource tab (Coordinate resource) is displayed in the right half of the preview 

area when a coordinate resource is specified in the property pane as the input 

resource. The resource tab (Coordinate resource) itself shows resource information 

of the coordinate resource specified in the property pane. 

 

 

 

Figure 10-22 Resource tab (Coordinate resource)  

 

Table 10-19. Items in the resource tab (Coordinate resource) 

No. item Description 

1 Coordinate resource name Shows the coordinate resource name 
specified as the input resource.  

2 Coordinates information Shows the coordinates information of the 
coordinate resource specified as the input 
resource.  

3 User memo Shows the user memo of the coordinate 
resource specified as the input resource.  
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10.7.5 Resource tab (Color resource) 

The resource tab (Color resource) is displayed in the right half of the preview area 

when a color resource is specified in the property pane as the input resource. The 

resource tab (Color resource) itself shows resource information of the color resource 

specified in the property pane. 

 

 

 

Figure 10-23 Resource tab (Color resource)  

 

Table 10-20. Items in the resource tab (Color resource) 

No. item Description 

1 Color resource name Shows the color resource name specified as the 
input resource.  

2 Palette Shows the color information[RGBA] image of the 
color resource specified as the input resource.  

3 Color information[RGBA] Shows the color information of the color resource 
specified as the input resource. 

4 User memo Shows the user memo of the color resource 
specified as the input resource.  
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10.7.6 Fit to the preview window 

Zooming in and out functions can be toggled in the main tab and in the image 

resource tab with the checkbox “Fit to the preview window.”  

When the checkbox “Fit to the preview window” is checked, the displayed image is 

zoomed in or out to fit to the preview area keeping original image’s aspect ratio. 

When the checkbox “Fit to the preview window” is unchecked, the image resource 

is displayed in its original image size, and can be zoomed in and out.  

 

Table 10-21. List of zooming in and out operations 

No. Operation Function 

1 ‘Ctrl’ key + Mouse wheel Zooming in or out 

2 ‘Ctrl’ + ‘+’ key Zooming in 

3 ‘Ctrl ‘+ ‘-’ key Zooming out 
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11  Macro 

  Macro functions 

You can save an operation procedure on WinActorEye to a file by using the Macro 

functions. A macro of WinActorEye can be run from a scenario of WinActor. 

 

  Edit macro 

"Edit macro" has functions for editing a macro of WinActorEye. Click "WinActorEye 

edit macro" in the "View" menu or click the "Edit macro" tab in the resource area to 

display the "Edit macro" pane. 

For details of the "Edit macro" pane, see "10.2  WinActorEye edit macro." 

 

 

Figure 11-1. "Edit macro" pane 

 

On the menu bar, there are menus for executing each function. For details, see 

"11.3 Menu bar." 

The macro area displays a macro being edited. For details, see "11.4 Macro area." 

When an editing operation is performed in the image input area of WinActorEye 

with the macro recording function turned "ON," the performed operation will be 

recorded in the macro area. 

Use the "Create" menu to save or load a created macro.  

Use the "Edit" menu to rearrange the order of operations in, change parameters of, 

or delete unnecessary parts in a recorded macro. 

Use the "Run" menu to check the operations of a created macro. 

For details, see "11.3.1 Create" to "11.3.4 Record." 
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  Menu bar 

 

11.3.1  Create 

The "Create" menu is to save or load a created macro. 

 

 

Figure 11-2. "Edit macro" pane (Create menu) 
 

 

Table 11-1. Create menu 

No. Function Keyboard Description 

① New ‘Ctrl’ + ‘N’ key Clears the macro area. 

② Open ‘Ctrl’ + ‘O’ key Loads a macro stored in a file. 

The file selection window appears when clicked. In 
the file selection window, select a file to be loaded. 

③ Save ‘Ctrl’ + ‘S’ key Saves a macro in the macro area to a file. 

The file selection window appears when clicked. In 
the file selection window, select a file to save a 
macro. 
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11.3.2  Edit 

Use the "Edit" menu to rearrange the order of operations in, change parameters of, 

or delete unnecessary parts in a recorded macro. 

 

 

Figure 11-3. "Edit macro" pane (Edit menu)  
 

Table 11-2. Edit menu 

No. Function Keyboard Description 

① Insert ‘Insert’ key Inserts a blank row. 

② Delete ‘Delete’ key Deletes a selected operation.  

③ Edit ‘Enter’ key Opens the "Edit macro item" window to edit 

parameters of a selected operation. 

For details, see "11.5 Edit macro item." 

④ Remove 

error/warning 

‘.’ key* Removes the error/warning for a selected 
operation. 

⑤ Up ‘-‘ key* Moves the order of a selected operation 
upward. 

⑥ Down ‘+’ key* Moves the order of a selected operation 
downward. 

⑦ Undo ‘Ctrl’ + ‘Z’ key Undoes the last edit operation.  

⑧ Redo ‘Ctrl’ + ‘Y’ key Redoes the last undone edit operation.  

* Can be operated only with the numeric keypad. 
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11.3.3  Run 

Use the "Run" menu to check the operations of a created macro. 

 

 

Figure 11-4. "Edit macro" pane (Run menu) 
 

 

Table 11-3. Run menu 

No. Function Keyboard Description 

① Run all ‘F5’ key Runs all recorded macro operations. 

If an error occurs, it will stop at that row. 

② Run selected  Runs a selected step in a macro. 

③ Step ‘F6’ key Runs a macro step by step.  
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11.3.4  Record 

The macro recording function can be switched "ON" and "OFF" by clicking the icon 

of the "Record" menu. 

 

 

Figure 11-5. "Edit macro" pane (Record menu) 

 

Table 11-4. Record menu 

No. Function Keyboard Description 

1 Record ‘F9’ key This is to specify whether to set the macro recording. 

When it is set to ON (enabled), performed operations 

will be recorded in the macro area. 

When it is set to OFF (disabled), performed operations 

will not be recorded.  
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Table 11-5. Macro recording setting and its display 

No. Setting Display 

1 ON (enabled) 

 

2 OFF (disabled) 
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  Macro area 

The macro area displays "No.," "Command," "Parameters," "Error/Warning," and 

"User memo" for a macro. "Command" and "Parameters" are set automatically during 

the macro recording. "Error/Warning" displays warnings during the macro recording or 

errors when running a macro. You can write notes in "User memo." For details of the 

macro area, see "Table 10-2. Items in the macro area." 

In the macro area, you can perform the keyboard and mouse operations shown in 

the table below. 

 

Table 11-6. Operations in the macro area 

Key Mouse Description 

↑ － Selects a previous operation. 

↓ － Selects a next operation. 

PageUp － Scrolls the macro area upward. 

PageDown － Scrolls the macro area downward. 

－ Click Selects a clicked operation. 

Enter Double-click Opens the "Edit macro item" window to edit parameters 

of an operation. 

For details, see "11.5 Edit macro item." 

Delete － Deletes a selected operation. 

Insert － Inserts a blank row. 

- * － Moves the order of a selected operation upward.  

+ * － Moves the order of a selected operation downward.  

. * － Removes the error/warning for a selected operation. 

F2 Double-click On the user memo field, double-clicking or pressing the 

F2 key changes the user memo field to the edit mode. 

F5 － Runs all macro operations. 

F6 － Runs a macro step by step. 

F9 － Turns the recording function ON/OFF. 

Ctrl +Z － Undoes the last edit operation.  

Ctrl +Y － Redoes the last undone edit operation.  

* Can be operated only with the numeric keypad. 
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  Edit macro item 

In the "Edit Macro Item" window, you can edit "Command name," "Error/Warning," 

"User memo," and "Parameters" for the selected operation in a macro. 

 

 

Figure 11-6. "Edit macro item" window 

 

 

Table 11-7. "Edit macro item" window elements 
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No. Element Description 

① Command name Shows the command name. 

You can edit it by clicking its input field. 

② Error/Warning Shows the error/warning. 

③ Remove Error/Warning  Removes the error/warning. 

④ User memo Shows the registered user memo. 
It can be used as a memo field when performing 
maintenance. 

You can edit it by clicking its input field. 

⑤ Add above Adds a parameter above the selected parameter. 

⑥ Add below Adds a parameter below the selected parameter. 

⑦ Delete Deletes the selected parameter. 

⑧ Parameters Shows the parameters being edited.  

You can edit them by clicking each parameter. 

⑨ OK Confirms your edit. 

⑩ Cancel Cancels your edit. 
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  Running a macro from a scenario of WinActor  

When you want to run a macro of WinActorEye from a scenario of WinActor, use 

"Eye_ReadAndRunMacro" provided as a library on WinActor. Place the 

"Eye_ReadAndRunMacro" library in the flowchart area of WinActor and specify a file 

path of the saved macro in the property window of the library.  

 

 

Figure 11-7. "Eye_ReadAndRunMacro" library 
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Figure 11-8. "Eye_ReadAndRunMacro" library property window 
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12 Notice 

  Behaviors on calling scenario file 

When WinActor starts executing a scenario, input data of WinActorEye will be 

initialized. However, when WinActor starts executing the ‘Call scenario file’ node or 

the ‘GoToScenario’ library, input data will not be initialized.  

 

  



 

 

WinActorEye  Operation Manual Behaviors on calling scenario file 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 WinActorEye Operation Manual 
 

NTT ADVANCED TECHNOLOGY CORPORATION 

Copyright © 2013-2025 NTT, Inc. & NTT ADVANCED TECHNOLOGY CORPORATION 

 

This document is protected under copyright law. It is forbidden to duplicate or copy any part or all of this document without 

prior consent. 

The contents of this document are subject to change without notice. 

WA7-R-20250814 

 


	1  Introduction
	1.1  About this document
	1.2  Trademarks
	1.3 Notes on this manual
	1.4  Recommended environment
	1.4.1  Hardware environment
	1.4.2  Software environment

	1.5  Launching WinActorEye

	2  WinActorEye
	2.1  About WinActorEye
	2.2  Terms and descriptions
	2.3  Operation flow of WinActorEye

	3  Main window
	3.1  Main window
	3.2 Docking window
	3.2.1  Dragging a title bar
	3.2.2  Dragging a tab
	3.2.3  Docking (entire window area)
	3.2.4  Docking (resource/property/preview area)
	3.2.5  Float/Dock menu
	3.2.6 　Saving and restoring the layout

	3.3  Operations in the image input area
	3.3.1  Registering an image resource
	3.3.2  Registering a rectangle resource
	3.3.3  Registering a coordinate resource
	3.3.4 Editing/viewing a rectangle resource
	3.3.5 Editing/viewing a coordinate resource
	3.3.6  Changing the zoom level


	4  Input
	4.1  Input menu
	4.2  Input image
	4.2.1  from File
	4.2.2 from Clipboard

	4.3  Snapshot
	4.3.1  Drop shadow
	4.3.2  Click to specify
	4.3.3  Specify window title name


	5  Output
	5.1  Output menu
	5.2  Output image
	5.2.1  to File
	5.2.2  to Clipboard


	6  Edit image
	6.1  Edit image menu
	6.2  Trim

	7  Filter
	7.1  Filter menu
	7.2  Terms used in parameters
	7.2.1  Number of pixels on a contour
	7.2.2  Number of allowable vertices
	7.2.3  Open and closed contours
	7.2.4  Roundness and level of correction

	7.3  Histogram search
	7.4  Detect rectangles
	7.5  Detect circles
	7.6 Search specified color
	7.7  Boolean operation
	7.8  Selection algorithm
	7.8.1  Center of image
	7.8.2  Uppermost/Lowermost/Leftmost/Rightmost
	7.8.3  Largest/Smallest
	7.8.4  Rectangles within range

	7.9 Extract coordinates from rectangle

	8  Tool
	8.1  Tool menu
	8.2  OCR tool
	8.2.1 Microsoft OCR
	8.2.1.1  "OCR tool" window operation procedure
	8.2.1.2  Windows language settings and Microsoft OCR language


	8.3 Color picker tool
	8.4 Barcode tool
	8.4.1 Read
	8.4.2 Write
	8.4.2.1 QR code
	8.4.2.2 Barcode



	9  Settings
	9.1  Settings menu
	9.2  Specify background color
	9.3  Clear all resources

	10  View
	10.1  View menu
	10.2  WinActorEye edit macro
	10.3  Image resource
	10.4  Rectangle resource
	10.5  Coordinate resource
	10.6 Color resource
	10.7 Preview
	10.7.1 Main tab
	10.7.2 Resource tab (Image resource)
	10.7.3 Resource tab (Rectangle resource)
	10.7.3.1 The case two resource tabs (Rectangle resource) are displayed

	10.7.4 Resource tab (Coordinate resource)
	10.7.5 Resource tab (Color resource)
	10.7.6 Fit to the preview window


	11  Macro
	11.1  Macro functions
	11.2  Edit macro
	11.3  Menu bar
	11.3.1  Create
	11.3.2  Edit
	11.3.3  Run
	11.3.4  Record

	11.4  Macro area
	11.5  Edit macro item
	11.6  Running a macro from a scenario of WinActor

	12 Notice
	12.1  Behaviors on calling scenario file


